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DISCLAIMER OF WARRANTY

THIS SOFTWARE PROGRAM AND DOCUMENTATION ("WJS") IS 
PROVIDED "AS IS" WITHOUT WARRANTIES OR CONDITIONS, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THOSE CONCERNING 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  BY USING 
WJS, YOU ARE EXPRESSLY RELEASING ANGEL BABUDRO FROM ANY LIABILITY 
RESULTING FROM THE USE OF THIS SOFTWARE AND DOCUMENTATION.  YOU 
MUST ASSUME THE ENTIRE RISK OF USING WJS.  YOU ARE ADVISED TO TEST 
AND SUPERVISE WJS THOROUGHLY BEFORE RELYING ON IT.

COPYRIGHT

WJS is owned and copyright (c) 1989-1992 by Angel Babudro, all 
rights reserved.  You may only use and/or distribute WJS under the License 
terms below.

LICENSE

1. WJS is being distributed as Shareware; it is not free.  You are 
granted a limited license to use WJS for an evaluation period of up to 60 
days, to determine if it suits your needs.  Any other use of WJS or use past 
this period requires registration.

2. You are granted a limited license to copy WJS only for the purpose 
of allowing others to try it, subject to the above restrictions as well as these: 
WJS must be distributed in complete & unmodified form, including all 
programme, documentation, and other files; WJS may not be included with 
any other product for any reason whatsoever without a license from Angel 
Babudro; no charge or payment may be levied or accepted for WJS except for
a fee of not more than US$6 for the disk and/or service of distribution; the 
file CONFIG.WJS is not to be duplicated except for back-up purposes.

3. Bulletin Board system operators may post WJS on their BBS for 
downloading by their users without written permission only if the above 
conditions are met, and only if no special fee is necessary to access the WJS 
files (a general fee to access the BBS is okay).

4. You may keep as many backup copies of WJS as you wish.  The 
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Registered Edition is limited to simultaneous use on the number of 
computers indicated on your license and opening screen.

TECHNICAL SUPPORT (HOW TO REACH ME)

Comments, criticisms, correspondence, witticisms, Christmas cards, 
and vast quantities of unmarked bills are welcome here. If you have 
questions or need help, just drop a note to me through the mail or a BBS 
listed below.  Registered users, vendors, and sysops may contact me via 
telephone as well.  Sysops and shareware vendors please see VENDOR.DOC 
for distribution information.

Mail Angel Babudro, "Organic Computer Wizardry", Box 132, 
Paonia, CO 81428 USA

Phone (303) 527-6756 Tue-Sat 10am-6pm Mountain Time

If I'm not home try reaching me at (303) 527-4866 (KVNF-FM).  I 
cannot return long distance calls - I've tried and it rapidly costs way more 
than I make from this shareware.  So if I'm not at KVNF and you get my 
answering machine at home, please try again later.  Thank you!

Official Distribution Bulletin Boards

My software packages are "free" downloads on the BBSs listed below 
- you need not subscribe to download my shareware (although other files or 
functions may require subscription).  I use the first name "Angelo" on BBSs 
since it avoids gender confusion (I'm used to both names anyway).  Scan for 
the file name WML*.* to locate the latest version.

East CoastExcalibur (Central NY) (315) 736-3792.  USR DS modem.  FREQ 
(File REQuest) from this board via RBBS address A:954/401, FIDO address 
1:26501, or ICN address 91:315/101.

WhiTech BBS (NC) (910) 944-1165.  Zyxel 14.4 V32b V.42b 
modem.  FREQ via Fido 1:3636/2.

SBA On-Line  (800) 697-4636.  9600bps V.32 modem
This is the U.S. Small Business Administration's BBS which 
contains business software only and is an access point for 
InterNet (InterNet access not available on their toll-free 
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number, you'll see details when you call).  A great service 
from the government.  When I upload a file to them, it is 
made available on the first of the next month.

Midwest Rusty 'n Edie's BBS (Ohio), six phone numbers:
(216) 726-1804  HST 16.8
(216) 726-3642 Hayes 28.8
(216) 726-3610 Hayes V-series
(216) 726-2620 2400/V32/ZyXEL 19.2
(216) 726-3628 HST Turbo 21
(216) 726-3584 CompuCom Speed

West Coast Researcher's BBS (CA) (805) 949-8151.  USR DS modem.  
Enter "J;136" to join the OrganicSftwr conference before downloading, 
browsing for topics of interest, or leaving messages to me.

Western Slope (CO) (303) 241-1966 USR DS modem.  This is 
my local BBS, so it's a good place to leave messages for me.  
It's run by a computer club & they allow 17 minutes per day 
to non-club-members so you'll need a high speed modem to 
grab the latest version.

UPDATES, ORDERING METHODS, AND REGISTRATION FEES

I hope that you are so happy with WJS that registering will be reward 
enough in itself, but I think it's more fun & exciting to get something new.  
And so you shall!  I do so much programming on this machine of mine that 
there are minor updates practically every week, so you will definitely get an 
updated version.  One day I realized that if I'm always updating my software 
some people will want to wait for that day when it's "done."  So I thought, 
"Hey, wouldn't it be nice if software publishers gave out free updates so you 
wouldn't have to wonder when the best time was to register?"  So I decided 
to do just that...

Updates Are Free

When you register you will receive the latest version of WJS.  
Thereafter, you can download new releases from a computer bulletin board 
system (BBS).  Just over-write the old files with the new ones.  The new 
version will recognize your registration "stamp" in your CONFIG.WDT file 
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(which is NOT distributed with the Unregistered Edition).  I must reserve the 
right to change this policy, but I foresee no reason to ever do so.  If you can't
find WJS on a bulletin board in your area, ask a sysop about File Requesting 
(FREQing) a file from one of the network addresses listed on page 2.

Updates through the mail are available through the mail for $7.00 
plus foreign shipping, if any.  If you send me a disk with return postage you 
can deduct $2 from the update fee.

How often is WJS updated?  At this stage I am releasing a new version
about every three months with a major update happening every eight to 
twelve months.

Benefits of Registration

1. You may order the complete manual, printed & 3-ring-bound or 
on-disk/ready to print for your laser printer.

2. The 7-second pause at start-up will go away.
3. Technical Support:  You will have a real person (no automated 

phone systems) who is 100% knowledgeable about WJS and can immediately
act on your questions, suggestions, comments, problems, etc.

4. You can feel terrific about having done the right thing.

How To Order

U.S. customers please send cash, check, or money order.  Canadian 
customers please send cash or Canadian International Money Order (CIMO).  
Customers in other countries please send U.S. funds drawn on a U.S. bank.  If
you send cash use a "security" no-see-through envelope and you may want 
to send it via Registered mail, too.  Purchase Orders only accepted from 
Fortune 1000 companies with a minimum $200 order.

Pricing

Registration with Disk — A single copy costs $69.  You will receive the 
latest Registered Edition of What Job Summary? with automated 
installation, the latest version of this documentation on disk, and 
notification of updates.  See below for printed & video manuals.

Multiple Copies / Wholesale — If you would like to resell What Job 
Summary? or have multiple locations at which you would like to install
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WJS, you may receive a discount as follows:
- 2-4 disk copies on the same order 40%
- 5 or more disks on the same order 50%

Site License — purchase one copy of WJS and add a Site License to use it 
on as many computers as necessary at a single location of a single
business.  Add the amount below to your registration fee:

Up to 4 computers $30.00 per site
Up to 10 computers $70.00 per site
Up to 20 computers $125.00 per site
Any number of computers $400.00 per site

Manuals — $12.  These are typeset with Ventura Publisher, printed on my 
laser printer, and placed in a 3-ring binder.  Your copy is the up-to-the-
minute latest version.  Each screen is shown and explained, basic 
data base terminology is presented, and an index is included to locate
topics quickly.  I am concerned about our planet hurting from 
deforestation, so I'd rather you didn't order a manual unless you need
more information than is presented here.

Complimentary Registered Editions - I'll give a complimentary 
registration for consideration as follows:

1. Upload a package to at least five public ("open") BBSs, fill in the 
Complimentary Registration form below, and I'll send you a 
complimentary registered disk.  It's nice if you upload to time-share 
systems, private ("closed") BBSs, or part-time BBS, but please do not 
use these to apply for a complimentary registered edition.

2. If you are a consultant or other type of computer professional and 
your recommendation leads to one or more of your clients purchasing one of 
my packages, just send me a note with your client's registration or have 
them mention your name when they register.  I will send a complimentary 
registered edition or an update for every registration you get for me.  This is 
in lieu of a multiple copy discount; I intend it for consultants who choose not 
to deal with sales tax.

One complimentary registration per person or company.  A 
complimentary registration is just like a paid one - you can upgrade it with a 
site license, purchase manuals, etc.  It helps when you send back disks to be 
re-used - even the envelopes can be re-used.  When you order a 
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complimentary registration please fill in the appropriate blanks below PLUS 
the Invoice so I know what size disk you need, and please send me a couple 
of dollar bills for shipping expenses.

I will promise these complimentary offers until at least 12/31/94 - 
after that date please check with me first.

COMPLIMENTARY REGISTRATION APPLICATION

Date_______________

Please also fill in the Invoice on the following page (put $0 for the 
disk).  Include $2.00 for shipping within the U.S. or the amount indicated for 
addresses outside the U.S.  Remember to order printed manual(s) if you so 
desire.

(__) I uploaded (archive name, like WJS12g.ARJ)_________________
to these five 24-hour public ("open") BBSs:

BBS Name                             Phone Number                           Modem Type  

1_______________________ ________________________ _______________
2_______________________ ________________________ _______________
3_______________________ ________________________ _______________
4_______________________ ________________________ _______________
5_______________________ ________________________ _______________

These offers subject to withdrawal or change at any time without notice.  
All prices are subject to change without notice.  Vendors and bulletin board 
sysops please see VENDOR.DOC, and sysops please also read SYSOP.DOC for 
special offers.

Angel Babudro ● "Organic Computer Wizardry"
PO Box 132, Paonia, CO 81428 USA

(303) 527-6756 Tue-Sat 10-6 Mountain Time

Please register the software you keep.
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INVOICE & REGISTRATION FORM
For Credit card orders see "How To Order" above

REMIT TO: FROM:
Name___________________________

Angel Babudro
"Organic Computer Wizardry" Company________________________
PO Box 132
Paonia, CO  81428  USA Address________________________
(303) 527-6756 10am-6pm Mtn

_______________________________

Phone__________________________

Registration Registration & disk: $69 x qty _____ $_______ 

Multiple Disks 2-4 disks: 40% disc, 5+: 50% disc. (_______)

Site License Up to 4 CPUs add $30; Up to 10 add $70
(add to above) Up to 20 add $125; Unlimited add $400 _______ 

Printed Manuals 3-ring bound Qty _____ x $12 = _______ 

Shipping & Canada, AK, HI, VI, PR add $3 extra _______ 
Expenses Other countries add $9 per copy _______ 

** T O T A L ** $_______ 

_____(Yes/No) Send new updates about every other month and bill me $7 
plus foreign shipping, if any.  I will send payment within seven days or return 
the disk & cancel this service.

Disk size & quantity [__] 3½" [__] 5¼"
Drive density [__] Low (DD) required [__] High (HD) ok
FDFORMAT/FDREAD [__] FDFORMAT extended densities okay

Printer make(s) & model(s)_______________________________________
Which version are you using now?_________________________________
Where did you get it (BBS/vendor name)?__________________________

WJS has been delivered to and accepted by customer.  Upon receipt of
this paid invoice you will be sent the latest Registered Edition disk and any 
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options chosen above.  Send cash, cheque, money order in U.S. funds; 
Canadians send Cdn$ or CIMO.  CO residents add local sales tax.  Mail this 
invoice with your payment.  Allow 1-4 weeks for the latest version to land on 
your doorstep.  Thank you for your order!
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WHAT DOES THIS SOFTWARE DO?

What Job Summary? is a tool to help you keep track of jobs for which 
you are contracted or sub-contracted.  WJS gives you an easy way to track 
summary information about your jobs; the estimating and details are left 
entirely up to you.  WJS then provides reports for the banker and bonding 
company as well as to help analyze your work load.

WJS can track up to 2.6 million jobs per year, which is a limit of the 
numbering system used; your practical limit will be determined by your 
computer speed & hard disk capacity and will probably be in the under-
10,000-jobs-per-year range.  For each of these jobs WJS has a place to enter 
the relevant bid, cost, and income figures - somewhat like a spreadsheet.  
Since WJS is not an estimating or billing package, it seems reasonable to 
assume that you will have total amounts calculated from another programme
(or by hand).  For this reason, WJS does not attempt to duplicate the 
functions of these other software packages, but rather it takes totals and 
puts them all neatly in one place and prints reports which are probably not 
available in your other software packages.

The function keys are the same as the Timberline estimating package.
Whether or not you are familiar with Timerline estimating, keep an eye on 
the bottom of the screen for function key definitions.

SYSTEM REQUIREMENTS

Any PC-compatible computer with at least 300k of free RAM should 
work fine, however a 286 or better and a hard disk are preferred since WJS is 
a data base application which inherently involves a lot of disk access.

WJS has been tested on MS-DOS 3.3 and 5.0.  It should work properly 
under PC-DOS or MS-DOS version 3.1 or later although I recommend only 3.3
and 5.0 be used -- it's worth the money to upgrade.  WJS's operating speed is
quite acceptable on an 8MHz 80286 computer.  You will need about 240k of 
disk space for WJS and its necessary files plus disk space for the information 
you will enter.  Any dot matrix printer should work fine.  If yours isn't on the 
list, try one of those that are - most use similar codes, the biggest variant 
being font codes.  If your printer won't work with what is there, please tell 
me and your registered edition (or update) will include your printer.
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Theoretically, WJS can accommodate 2.6 million jobs per year and 
each job can have up to ten lines.  WJS uses 109 bytes per line of data, so 
you will need 11k to 107k of storage per 100 jobs entered depending on the 
number of lines used.  Data base applications, such as this one, tend to 
access the disk frequently so it is much better to use a hard disk, but WJS 
can run on a floppy.  In its minimum configuration, WJS requires about 216k 
of storage, so a 360k floppy disk will have room for about 1,300 lines of data.

FILES WHICH MAKE UP THE PACKAGE

What Job Summary? consists of the following files:

file_id.diz * Description file for BBSs
desc.sdi * Description file for BBSs
WJS.EXE The executable file
WJS.HLP The help file
WJS.TXT * The ASCII file of this document
WJS.WP * WordPerfect 5 file of this document to format for your

printer
READ.ME * A file containing late-breaking news
ORDER.FRM Order form for all of my software — please "TYPE 

ORDER.FRM > PRN" to print it
PRINTER.DAT Printer codes
SYSOP.DOC * Registration offer for BBS sysops
VENDOR.DOC * WJS distribution information

These are the files which make up WJS.  If you distribute evaluation 
copies to friends and bulletin boards please be sure to include all of these 
files.  Additional files will be created in the same directory as you use the 
software.  The files marked with an asterisk (*) can be deleted if disk space is
a premium, but I ask that you please keep ORDER.FRM on disk until you 
decide whether or not to register.

Registered users — please keep the file CONFIG.WJS only for yourself 
as it contains your registration key and system settings.  Share only those 
files listed above.

RUNNING What Job Summary? FOR THE FIRST TIME
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   If you received your copy of WJS on disk it has an installation programme 
on it.  Using INSTALL is faster than setting up manually, and it won't change 
your AutoExec or CONFIG, so I'd suggest:

1. Put the floppy in a drive
2. Type "d:INSTALL" where "d:" is your drive (e.g., "A:")

INSTALL is not necessary, however.  If you have received WJS from a 
bulletin board then you have installed it by unpacking the archive.  I strongly 
suggest that you put the software in a directory of its own (for example, C:\
WJS).  You can run the package from any directory since data files will be 
created if they are not present.  In this way you can also keep more than one
set of data files by using different directories.

Documentation Files

If you have WordPerfect 5, just load WJS.WP.  Instructions for re-
formatting are in a comment at the top of the document.  If you don't have 
WordPerfect 5 or a way to convert the WJS.WP file to your word processor, 
then use WJS.TXT which is an ASCII file generated from WordPerfect for a 
"standard printer."  Your printer should be set to CR/CR (carriage return does 
NOT produce a line feed), which is the most common setting.  If you see 
double printing of titles change this setting.

After INSTALL is finished you can type "WJS" to start What Job 
Summary?.  The "WJS" command runs a batch file which merely changes to 
the proper drive & directory then runs WJS.  You can delete this file if you are 
using a menu or would rather type the commands yourself.

Using the Menus

WJS employs the familiar, standard 2-dimensional pull-down menu 
system.  There is a horizontal menu of choices — File, Data Entry, etc.  Under
each of the horizontal choices is a menu of functions pertaining to that item 
— it is a two-dimensional menu, in other words.

There are three ways to select an item from the menu:

1. Press the letter which is highlighted in the option description
2. Use the Up/Down/Right/Left arrows to highlight the option you 
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want then press ENTER (a.k.a. RETURN or CR)
3. Use a mouse to select the option you want (click with the left 

button)

Some sub-menus (such as the Help Index) do not have highlighted 
options.  On these menus you must use the arrow keys to highlight your 
choice then press ENTER.

If you want to cancel an operation you selected, just press the Esc 
("Escape") key.

Quick Start

Type "WJS" and press ENTER; press "P" (Preferences) and go down the
list of choices, setting each screen as you see fit.  There is on-line help which
can be accessed by pressing the F1 key while on any data entry screen or via
the "Help" menu's "Index" option.

FILE MANAGEMENT AND EXIT

The choices under the File menu have to do with your system set-up, 
file management, and ending the programme.

Year-end Close-out

The purpose of this function is to remove jobs history from the files, 
thus freeing up disk space.  When you select this option you a window will 
open with three fields to fill in:

1. Cut-off year (assumes current year minus 2) - All data during or 
before this year will be erased from the file.

2. Keep pending jobs on file - If you answer "Y" (Yes) then jobs with 
a "P" (pending) status will be kept on file, regardless of their bid date.

3. Report to printer - If you answer "Y" (Yes) then all jobs which are 
removed from the file will be printed.  An audit trail, if you will.

Rebuild Indices
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This function is provided in the event you ever have a power outage 
or for some other reason the index files become damaged.  If you notice 
anything strange -- like dates are in the wrong order, records are 
mysteriously missing, etc. -- just rebuild the indices and they'll probably go 
away.

Making Back-up Copies of Your Files

File/Back-up protects your information by allowing you to copy it to 
another disk.  Using Preferences/Back-up you should have decided how you 
wanted to perform a back-up -- using the DOS COPY command, ARJ, LHARC, 
or PKZIP (the default is DOS COPY).  After you select File/Back-up you will see
a summary window and the system will pause for you to enter the back-up 
destination (which is typically a floppy disk drive, but you may decide to 
back-up to another hard disk, a network drive, etc.).  All WJS data files will 
then be backed-up to the destination disk and directory using the method 
shown in the window.

Please see also the section on choosing a back-up method under 
Preferences.

Restoring Files from a Back-up Copy

If you ever need to recover data files from a floppy disk you made 
using the Back-up command (above), just place the floppy disk in its drive, if 
applicable, and select File/Restore.  The method used to restore the files will 
be the one specified on the Preferences/Back-up window.  The system will 
pause for you to enter the source drive -- the one you used when backing-up,
which is typically a floppy disk drive, but may be another hard disk, a 
network drive, etc.  All WJS data files will then be restored from the back-up 
copy to the WJS directory.

Please see also the section of choosing a back-up method under 
Preferences.

Formatting Floppy Disks

This option is for those times when you have decided to make a back-
up copy of your data but don't have a formatted disk handy or want to re-
format a disk to check for any bad spots.  File/Format Floppies lets you 
format a floppy disk to your computer's standard density without exiting WJS.
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By "standard density" I mean that if you have a high density drive you can 
only format high density disks (in other words, WJS doesn't pass any 
parameters to DOS FORMAT).  There is an exception to this:

If you have What Floppy Format? (WFF.EXE) available somewhere in 
your DOS search path, WJS will automatically access it for formatting floppy 
disks so you can format any kind of disk using FDFORMAT.  (You will receive a
complimentary copy of the latest version of WFF with your WJS registration.  
FDFORMAT is a Freeware product by another author and can be found on my 
support BBSs.)

DATA ENTRY ("JOBS")

The Jobs menu of What Job Summary? lets you enter the data 
pertaining to your jobs.  There are two data entry screens:

1. General job information (number, name, bid amount, estimated 
cost, and bid due date)

2. Cost figures (bid amount, original estimated cost, cost to date, 
billed to date, revised estimated cost)

NOTE:  You must first create a job on the General screen 
before you may access it on the Cost Figures screen.  New jobs
can only be added on the General screen.

Notice the available function keys at the bottom of the screen: F1 
always saves and ends the current operation (e.g., if you are entering 
a line of information for a job, pressing F1 will save the line and end 
data entry for that job).  F2 always cancels the current operation 
without saving (old values are restored) (e.g., if you are entering 
changes to a line and press F2 the old data for the line will be 
restored and data entry for that job will be ended).

Entering New Jobs

While on the General screen press the Ins (insert) key.  The cursor will
"jump" to the bottom of the window and wait for you to start entering 
information.  WJS will attempt to guess the next job number based on the 
default job letter (defined on the Preferences/Fiscal Year screen), the current 
fiscal year (defined on the Preferences/Fiscal Year screen), and the last job 
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number on file for that letter & fiscal year.  Press ENTER after each item you 
enter.  Use the up and down arrow keys to move between the fields and the 
right/left arrows to move around within a field.

Editing Existing Jobs

To change information on either the General Info or Costs screen just 
highlight the line you want to change and press ENTER.  You can then change
anything on that line except for the job number (Job numbers are key items 
in the files and can't be changed).  If you must change a job number you will 
have to delete and re-enter the information.

Job Codes

Each job must have a unique identification code.  Each job code may 
have one to ten lines of information.  Each line may have it's own status, 
dollar amount, and bid due date.  This allows you to group separate elements
of a similar job together under one job code.  For example, let's say you are 
bidding on a job that will take several years to complete and has been split 
into four phases; you are bidding separately on each phase.  When you enter
the job you can put a "Phase I" line, a "Phase II", line, etc. and enter the 
dollar amounts, status, and bid date for each phase.  If you get two of the 
bids just mark those two phases as "Y" (yes) and the other two as "N" (no).

The format of a Job Code

Job codes are entered in the format "A#####" where "A" is a 
letter used to segregate jobs (perhaps different departments in your 
organization, different companies owned by a larger corporation, or 
for different types of jobs) and "#####" is a job number from 00000 
to 99999.  I recommend that you use the format "Ayy###" where 
"yy" is a two-digit year, or the format "Ay####" where "y" is a one-
digit year.

Using this format of job numbering gives WJS a simple but 
effective and flexible means to separate jobs.  If you have no need to 
separate your jobs just make them all one letter such as "A" or the 
first letter of your name.

When you add new jobs WJS will automatically supply the next 
available job code based on the default job letter & fiscal year 
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entered on the Preferences/Fiscal Year screen.  You can type over this 
with a new job code as necessary.

How Many Jobs Can I Track?

The filing system used by WJS can store 5.5 million records per 
file.  Since each line is a record this gives WJS a theoretical limit of 5.5
million lines of job information, although even the fastest PC would 
have trouble with a file that large.  (See System Requirements, above,
for disk storage requirements.)

Practically speaking, then, WJS is unlimited except by your hard 
disk and computer speed.  The rule of "Ayy###" works well, but if 
you have more than 26,000 jobs per year or if you need to have more 
than 1,000 jobs under a letter then you can make up your own 
numbering scheme.  A good alternative would be to use a single digit 
year (Ay#### - for example, J21001 for department J, year 1992, job 
#1001) which would give you 260,000 jobs per year for ten years.  
Whatever numbering scheme you use, remember that each job must 
have a unique code.

Dollar Amounts

Enter currency figures without any symbols, such as commas.  The 
only non-numeric character allowed is a period/decimal point.

Bid Date

Enter the bid date in the form "mmddyyyy" (month/day/year).  For 
example, "01011992" is Jan. 1, 1992.  The slashes are entered for you.  Be 
sure to fill in all numbers, even zeros — "1192" won't work for 1/1/92 -- enter 
"010192" instead.

REPORTS

Rather than describing each report here, it makes more sense for you 
to print a sample of each.  Just highlight the one you want, follow the 
instructions on the screen.  The Status Report has a sub-menu from which 
you must choose one or more report options.  The Work On-hand/Completed 
report has a sub-menu for which one item must be chosen.
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One note: I have chosen to use the extended graphics characters 
(ASCII 127-254) rather than use the rather crude vertical bars (|), plus signs, 
etc. for the reports.  Most printers made after 1982 are able to print these 
characters and it allows WJS to print nicer looking reports.  If you experience 
problems (e.g., you see a line of italic Ms or Ds where a horizontal line should
be) look in your printer's manual for a Character Set 1 or 2 setting, which 
may be a DIP switch or a front panel menu setting, and change it.  If you 
have trouble you can call me and I'll try to help.

PREFERENCES

The Preferences menu contains options which help you customize the 
operation of WJS and set necessary parameters, such as the type of printer 
you have.  Please check each Preferences screen before making full use of 
WJS, otherwise something might seem wrong with the software whereas it is 
due to the set of conditions under which WJS is operating.

Settings: Back-up Method, Country, etc.

Under the File menu is an option which allows you to back-up & 
restore your data to/from other disks for safety.  These operations will use 
the DOS COPY command unless you use this option to change it.

You will see a menu of four choices of methods to use when backing-
up and restoring:  DOS COPY (the default), ARJ, LHARC, or PKZIP.  In order to 
use ARJ, LHARC, or PKZIP compression software you must have the 
compression programme available in your DOS PATH.  In addition, you will 
also need enough free memory (RAM) to run both WJS and the compression 
software.

Country setting

WJS does not yet make use of this setting, but I have put it in the 
menus for near-future use.

Fiscal Year

To give you a report of your job activity for your company's fiscal 
year, WJS needs to know the beginning month of your fiscal year.  Select 
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Preferences/Fiscal Year and enter the beginning month number (1 for 
January, 2 for February, etc.).  Highlight the "Ok" button and press ENTER or 
just press F1 (function keys are shown at the bottom of the screen).

WJS assumes you have a wide-carriage (15-inch) printer for the Work 
On-hand/In progress reports since it is a 200+ column report.  If you have a 
10-inch (narrow carriage) printer you won't be able to print the Work reports. 
On a laser printer you can manually set the printer for landscape mode and a
small font like Line Printer.

Defining your Printers

Before you can print anything you will have to tell WJS which printer 
you will use.  WJS can print reports on PCL lasers or dot matrix printers, 
although the Work On-hand/Completed reports are so wide that they require 
15-inch paper or a very, very tiny font.  Until you define your printer(s) and 
font(s) there will be a flashing message at the bottom of the screen and you 
will not be able to print anything.

The Printer definition window shows the current settings.  Use the 
arrow keys to move around, and press the F3 key to change anything.  For 
example, to set your printer move the cursor down to that line then press F3 
and a menu of choices will appear.  Highlight your printer (or one compatible 
with it) and press ENTERr.  Then move down to the font definition and press 
F3 again.  Highlight your font selection and press ENTERr.  When you are 
finished, highlight the "Ok" button and press ENTER.  Alternately, you can 
press F7 to save the screen and exit.

Default Directory for Laser Printer Soft Fonts

If you define a laser printer you can set a default soft font 
directory by highlighting this field and pressing F3.  Enter the 
directory name on your hard disk (e.g., "D:\VENTURA\") which 
contains your soft fonts.  WJS will check to see if the directory name 
you entered is valid and if it exists, and will inform you if not.  Then, 
when you set fonts for printing, you can choose the "Soft font" option 
and select from your fonts on disk.

HELP
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The Help menu has two options:  About and Index.  "About" gives 
some information about the programme and free memory.  Index gives a 
menu from which you may choose a topic and press ENTER, whereupon a 
helpful window of information will appear.  :)  It's a handy (albeit brief) on-
line manual.

ERROR MESSAGES

WJS has three types of errors which you may experience:

1. Logical error - this is a minor problem, not really an error at all.  
An example of this type of error is if you try to enter a duplicate job number.  
These "errors" will appear in a window and, once you press ENTER or click on
"Ok" WJS will continue its operation.

2. File error - these problems cause an error screen to appear which
suggests a possible solution to the problem and, if you can't fix it, my 
address and phone number is shown so you can mail me the error or call me.
A common reason for this error is that an index file contains a bad entry 
(perhaps due to a power outage).  The most common solution to these 
problems is to re-index your files (File/re-Index).

3. Programme error - this is a mistake of mine and will cause the 
programme to abruptly end with a one-line error message and a message 
like "Press any key to return to system."  Report these errors to me right 
away, please.  WJS is a large huge programme and the bigger it gets, the 
more likely it is that a few bugs will creep in there somewhere.  These errors 
get top priority and are usually fixed and a new version released within a day.

If anything happens that you don't understand, or if you can't get WJS
to do what you want, I would appreciate knowing about this so I can fix the 
software or update the documentation as necessary.  Thank you for your help
and support!  :)
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